IN THIS CHAPTER

» Exploring tools and menu items

» Creating your first screen

» Comparing Design versus
Prototype mode

Chapter 1
Introducing the XD
Workspace

dobe Experience Design (XD) is a high-fidelity prototyping tool used to

demonstrate apps and website designs. In this chapter, you find out how

to use XD’s design tools to create your UI (user interface) quickly using
features such as shapes, text, grids, reusable components, layers, and more. Keep
in mind that Adobe XD is updated at a rather fast pace so there may be slight dif-
ferences in the feature set from the time of writing. Another note: Although XD
works on both the Windows and Mac platforms, you may see slight differences in
the UL Those differences will be addressed when appropriate.

Adobe Experience Design is included in your Creative Cloud subscription. If you do

not have it already installed, launch your Creative Cloud application and install it
before trying to follow along with this minibook.

Understanding the Modern User Interface

XD’s clean and simple UI has been created from scratch with the user’s experi-
ence in mind. After you discover the primary tools, you will easily be able to inte-
grate XD into your production workflow. XD is like Adobe Illustrator; in fact, many
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Ilustrator users prefer the simplicity of XD’s interface. To discover these tools,
you can build a new document and follow along with the exercises in this chapter.
Throughout the chapter you will take steps toward building a complete, working
prototype with art, images, text, and hyperlinks. You can then dig into the details
of those steps in the following chapters.

Creating a new artboard

In this chapter, you can follow along to learn while using some of the basic fea-
tures. As with most of the other Adobe applications, you will want to define an
artboard size before working in Adobe XD. You can choose from artboards that are
standard screen sizes, or create a custom-sized artboard. The size of the artboard
can be changed at any time. To create a new artboard, follow these steps:

1 . Launch Adobe XD.

A start screen appears that introduces you to the XD application and offers you
a choice of screen sizes. Your selection creates an artboard of that specified size.
Figure 1-1 shows the drop-down menu for the iPhone 11 Pro Max artboard. By
opening other drop-down menus, you can access other mobile sizes.
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FIGURE 1-1:
Selecting the size (2
of the artboard.
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FIGURE 1-2:

In the Windows
XD workspace,
the menu is
accessed in the
top-left corner.
On the Mac,
the Main menu
appears at

the top of the
workspace.

2.

Select an artboard size from the drop-down menu and press the Return

or Enter key.

The artboard appears in the XD workspace.

The workspace includes a work area in the middle, a main menu across the top
(Mac only), an application menu above the work area, a toolbar to the left, and
a Property Inspector on the right; see Figure 1-2.
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Using the tools
= H Design Prototype
In XD, primitive shapes, as well as more Select — T
advanced drawing tools, are available to Rectangle — |-
you on the toolbar. In addition, some other Ellipse — -0
tools, such as the Select and the Artboard
tools, might be familiar to you if you use Polygon —-2
Adobe Illustrator. See all tools in Figure 1-3. Line —-~
Pen —#
Text —T
Relating Objects to the o L
g J Zoom —-a
Property Inspector
In this section, you use the tools to place x
objects on the artboard so you can see the
relationship between objects and the Prop-
erty Inspector: Libraries —
Layers —=
1. with an artboard of any size open, Plugins —1-m
double-click on the artboard name that
appears at the top of the artboard to FIGURE 1-3:
activate the textbox and change the XD tools.
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TIP

3.

name of the artboard to “home.”

Creating a name for your artboard is helpful so that you can identify it easier in
the Layers panel or other menus.

Choose the Ellipse tool and click and drag an ellipse on the screen.

As with other Adobe applications, you can press the Shift key while dragging to
create a perfect circle. You can also press Alt/Option+Shift while dragging to
create a circle generated from a center point.

When the ellipse is complete, its properties now appear in the Properties
Inspector on the right, as shown in Figure 1-4.

The Ellipse tool is still selected. To avoid unexpectedly creating another
circle, click the Select tool.

Centering an object on the screen

The Align options at the top of the Properties Inspector are helpful when you
want to align the circle with the center of the artboard, horizontally or vertically
(or both). The Distribute options are not relevant unless you have more than one
object selected. Further down the Properties panel are other items, such as Repeat
Grid and Component. These features are discussed in context later in this book.
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FIGURE 1-4:

When an object

is selected, its
properties appear
in the Properties
panel.
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Using transform features

In the Transform section, shown in Figure 1-5, you can adjust the size of your
selected object using the Width and Height textboxes and change the position of
your selected object by changing the x, y coordinates. In this section, you work
with these and also flip your object vertically and or horizontally.

Some advance features such as scroll groups allow you to define areas of content
that can be scrolled horizontally, vertically, or in all directions. This is perfect
when you are trying to replicate an experience of panning a map or when you
have multiple, scrollable, panels on one screen. You will find out more about scroll
groups in Chapter 2, “Working with Artboards.”

Click the 3D Transform button in the upper-right to access 3D transformation
tools such as x and y rotation in a 3D space. The 3D transform mode the rotate
icons appear. To use these, choose whether you want to rotate on the x-, y-, or
Z-axes.
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FIGURE 1-5:

The transform
section of the
Properties panels
offers many
opportunities to
resize and shape
your object(s).
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Fixing position when scrolling

Click the Fix Position When Scrolling checkbox to keep the selected object from
scrolling with the rest of the content. This is a great feature that allows you to
build a navbar that stays put while the rest of the content on a screen scrolls. This
will be demonstrated when you preview the screen, and it is discussed in more
detail in the next chapter.

Laying it all out

In this section, two simple choices appear under Responsive Resize: Auto and
Manual. You can choose to have your selected object automatically resize, based
upon the artboard, or stay fixed in size. You could use this feature when designing
multiple views of your website or app. Many designers clone an artboard by using
Alt/Opt and dragging an artboard to a new location and then resizing it to show a
view of their design for phone, web, or tablet.

To try these features out, follow these steps:
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FIGURE 1-6:
You can set-up
your objects
to resize
automatically
when the
artboard

is resized. See
results of

the resize on
the right.

Auto resizing

If you simply want imagery and other content to shrink and grow when an art-
board is expanded or reduced in size, you can take advantage of the Auto Resize
feature. Try these simple steps to see how it works:

1. you do not already have an artboard, use the Artboard tool to create
one in any size.

. While the artboard is selected, turn on Responsive Resize in the Layout
section of the Properties Inspector.

. Select any shape and click and drag to add it to the artboard. In this
example, select an ellipse.

. Hold down the Ctrl (Windows) or Command (Mac) key and click on the

2
3
4. Click the Select tool.
5

artboard to activate it.
6

. Click and drag one of the side handles to widen the artboard. Note
that the ellipse automatically resizes with the artboard, as shown in

Figure 1-6.
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Manual resizing

If you don’t want all the content on your artboard to automatically resize, you can
select some of your objects and keep their size fixed. This basically freezes them so
that they do not expand or shrink when the artboard size is adjusted. Here’s how:

1.
2.

3.

If you do not already have a shape on an artboard, create one now.

Click the Responsive Resize switch in the Layout section of the Properties
panel.

Click the Manual button and click Fix Width and Fix Height to turn off
those settings.

The lines in the Ul are blue if the feature is set on, gray if they are turned off.

Select the artboard by clicking on the Artboard name, or Ctrl/Command-
clicking on any empty space in the artboard.

Grab one of the side handles and click and drag to resize the artboard.
Notice that the object resizes with the artboard.

Press Ctrl/Command-Z to undo and try fixing the size of the object by
selecting it again and clicking back on the Fixed Width and Height con-
trols. Now when you resize, it stays the same size.

Changing the appearance of your object

In the Appearance section of the Properties panel, you can change the opacity, fill
and border (stroke) or deselect either by unchecking the checkbox to the left of the
attribute. In this next step, you use the Properties Inspector to change the size,
position on the page, and the fill and border colors:

1.

2.
3.

4.

©

REMEMBER

With your ellipse selected, click the textbox to the right of W (Width) in
the Properties panel and type 200.

Type 200 in the textbox to the right of H (Height).

Easily center the circle horizontally on the page by clicking the Align
Center button at the top of the Properties panel.

If you prefer keyboard shortcuts, you can press Shift+C to do the same thing.

With the Ellipse still selected, click the box to the left of Fill in the
Properties Inspector to open the Color Picker, as shown in Figure 1-7.
Choose any color you like. If you want a color that is not displayed, click
and drag the Hue slider to the right.

Color, gradients, and transparency are covered in more detail in Chapter 3 of
this minibook.
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FIGURE 1-7:
Choose a color
for your fill from
the color picker.

TIP

Heme

LAY UL

Auto *anual

Solid Color v

1

o
lend Mot
Marmal
3 Hl
B Bl corcer
ize 1 Jash 0 Gap o
+ Elk E &
L L %

D r___| Shadow

D Background Blur v

Responsive Recize ‘3

oo

5.
6.

Click the box to the left of Border to select any stroke color.

Select the width value below the Border and type 10 so that you can
see a 10 pt border on your ellipse.

You have many options to select when you want to use a border, as you see in
Figure 1-8. These options allow you to change the corner points, add dashed
lines, and more. You will find out more about borders on Chapter 3, “Creating
Your User Interface (Ul) with Shapes, Paths, and Custom Shapes.”

You can use sliders to change values in the Properties pane — like for your
border, for example: Just click and drag up or down on the selected value.

As a bonus, add a drop shadow using the Properties Inspector: With your
ellipse still selected, check Shadow. The values that appear beneath are
the X and Y coordinates and the blur.

If you have been following along, choose to close your file by clicking on the
Close box in the upper-right corner. You do not need to save this file; you will
be starting a new example in the next section.
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A Little Bit about Artboards

In the previous section, you became familiar with ways to create objects and
change their properties. In this section, you create a set of three artboards in order
to investigate the properties associated with artboards:

1. create a new XD document by pressing Ctrl+N (Windows) or Command+ N
(Mac 0S).

2. Forthis example, choose any of the default size artboards displayed in
the New dialog box. In this example, the iPhone artboard was selected.

After you click on the artboard size, a new document appears with the first
artboard ready to go.

616 BOOK 6 Adobe XD



Saving your file

This is a good time to save this file. In Adobe XD, you can save either locally or to
the Adobe Cloud. Why two methods? It depends on the amount of collaboration
you are looking to enable. By saving your file as a cloud document, you can access
it across multiple platforms and devices. This can be helpful when you want to
share your document for comments and or development. You find out more about
saving as a cloud document in Chapter 9, “Sharing your XD Project.” Now, how-
ever, you will save the file locally, which means to the hard drive on your current
device:

1.

2.

Click and hold the burger menu in the upper-left and then choose Save as
a Local Document (Windows) or File>Save as a Local Document (Mac).

In the File Name section, name this practice and browse to a location
where you want to save this file. Keep the Save as Type as XD File and
press Save. Keep this file open.

Double-click on the artboard name, at home
the top of the artboard, and change the
name to home. When you start creating mul-
tiple artboards it is good practice to provide
each with a descriptive name.

Now add a simple graphic element to the home
screen.

Using the Ellipse tool, click and drag the art-
board to create an ellipse. It can be any size

or color, but position it somewhere near the
top of the screen.

With the ellipse selected, click the Align
Center icon at the top of the Properties
Inspector.

Your screen should look similar to the one
shown in Figure 1-9.

Now add some text to this screen.

Select the Type tool and then click and

release to create a text insertion point. FIGURE 1-9:

If you click and drag, you will create a text area Create a screen and add an ellipse
that is not as dynamic when you add additional Wit any color fill.

characters to your text. More details about

controlling text are covered in Chapter 5, “Working with Text in Your XD Project.”
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The screen now
has a graphic
element and a

618

7. Type the word Welcome in the Properties Inspector and choose any
size type in Text section — for this example, choose 50 pts. Also, choose
Center to center the text. To make sure the text object is in the center of
the artboard, click the Align Center (Horizontally) button at the top of the
Properties Inspector.

Your screen should look similar to the example in Figure 1-10. For more type
features, see Chapter 5, “Working with Text in Your XD Project.”
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Cloning your text objects to the
first artboard

These steps add additional text elements to the first page. Later, you will create

links

1.
2.

from these text objects to other artboards:

Using the Select tool, click the Welcome text that you just created in the
previous section.

Hold down Alt/Option and drag a clone of the text down and away from
the first text.
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Double-click on the new text field and type See dog.

P

Repeat the cloning step by selecting the textbox that states “See dog”
and then Alt/Opt-dragging it down underneath the original text.

5. Double-click the text and change it to See cat.
The result should look like Figure 1-11.

6. If you want to evenly distribute the lines of text, select all three and then
click the Distribute Vertically icon at the top of the Properties Inspector.
(See Figure 1-11.)

home ™ # h ) = 2 :l@
88 Repeat Grid B & @& &
COMPONENT (B +
TRANSFORM (T} @
W — £ 111 (O
() v 428
Welcome. pa o T &
OSee dogo D Fix Position When Scrolling
FIGURE 1-11: O_O_OSee cat YSE0T (9
C.Io.ne your Responsive Resize @
original text
object by holding Auto Maral
down the Alt/
Option key and -
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Duplicating your artboard

There may be instances when you want save steps by using an existing artboard to
build other screens. Follow these steps to duplicate the artboard you named home
in the previous section.

1. click on the name of your layer, home, at the top of the artboard to
select it.
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2. Inthe Layers panel on the left, look for your artboard name, right-click
(Windows) or Control-click (Mac) it, and select Duplicate from the contex-
tual menu, as shown in Figure 1-12.

A new artboard appears above home named home-1.

3. Double-click the home-1 name in the Layers panel, and change it to dog.
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D See dog See dog
Q See cat See cat
FIGURE 1-12: o
Duplicate and
rename your ®
new layer.

Creating a third artboard by cloning

You can also clone an existing artboard to start building from existing elements
on a screen. You clone objects in XD much like you would in other applications, by
using the Alt or Option key. Follow these steps to create a third artboard:

1. Make sure you have the Select tool active.

Click the dog name at the top of the dog artboard you just created to
select the artboard.

2.

3. Hold down the Alt (Windows) or Option (Mac OS) key and click and drag a
third artboard to another location in your XD document.

4.

Double-click the name at the top of the new artboard and change it from
dog-1 to cat.
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Editing your text to fit the screens

In this section, you change the text on the dog and cat pages so that you can link
to them later.

1. onthe dog page, double-click the text object that states See dog and
change it to This is a dog.

2. Onthecat page, double-click the text object that states See cat and
change it to This is a cat.

3. Save the file by pressing Ctrl+S (Windows) or Command+S (Mac).

Experimenting with artboard properties

You now have three artboards: home, dog, and cat. In this section, you change the
background color of your artboards and turn off and on precision layout and grid
tools that help you keep your designs neat:

1. withthe any artboard selected, click the box to the left of Fill, in the
Appearance section of the Properties Inspector, and select any color of
background for your new artboard. For this example, select a light tint so
that text in the design is still visible.

2. Check the box to the left of Layout in the Grid section of the Properties
Inspector in order to display a layout grid that is visible to you only while
working in XD. Change it to a square grid by clicking and holding down
Layout and selecting Square.

. ange the size to 20 pixels, as shown in Figure 1-13. Keep in mind that
3. c¢h he size to 20 pixels, as shown in Figure 1-13. Keep in mind th
you can hide this grid at any time by unchecking the Grid checkbox.

Adding an image

To make our app just a little more exciting, you can add some images to the cat
and dog pages. This won’t produce a beautiful app, maybe, but it will certainly
create a functional one:

1. Remove the circle graphics on all three screens by selecting them and
pressing Delete or Backspace.

2. Select the dog artboard and then choose Burger menu->Import
(Windows) or File->Import (Mac).

An Open dialog box appears.
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You can import any images that you like, but if you downloaded the
DummiesCCFiles folder, noted in Book 1, Chapter 1, you can use the pre-
pared exercise files for XD.

3. Navigate to the DummiesCCFiles folder and to the folder named
Book07_XD and select the image named BrownWhitePup. Hold down Ctrl
(Windows) or Command (Mac) and click the home-icon.svg file to add the
second image to your selection, and then press Import.

The files are added to the dog artboard.

4, Arrange the dog image and the home button on the page. If you want to
horizontally align them on the center of the page, press the Align Center
button at the top of the Properties panel or press Shift+C.

5. Now select the cat artboard and repeat the procedure, choosing the
Burger menu->Import (Windows) or Filer>Import (Mac). In this example,
the GrayKitty, jpg image and the home-icon.svg image are used.

6. If you want to add an image to the home page, use the image named

babyanimals@1.

After you have arranged the images on the artboards, the result may look similar
to Figure 1-14. Note that in this example the square grid lines have been turned off
so that you can see the screens better.
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Keyboard Shortcuts for Navigating
the Workspace

Now that you have several artboards, you can practice navigating your workspace.
Practice using the keyboard shortcuts provided in Table 1-1.

TABLE 1-1 Keyboard Shortcuts for Navigating the Workspace

Windows Shortcut

Mac Shortcut

Function

Fit all artboards in window Ctri+0 Command+0

Zoom in Ctrl++ (plus sign) Command++ (plus sign)
or or
Alt+mouse wheel Option+mouse wheel
Zoom out Ctrl+- (minus sign) Command-+- (minus sign)
Go to 100% Ctrl+1 Command+1
Go to 200% Ctrl+2 Command+2
Zoom to selection Ctrl+3 Command+3

(continued)
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TABLE 1-1 (continued)

Function Windows Shortcut Mac Shortcut
Full screen N/A Ctri+Command-+F
Scroll Spacebar and push with mouse

Horizontal pan Ctrl+mouse wheel Ctrl+mouse wheel
Vertical pan Mouse wheel Mouse wheel

On a laptop, you can simply pinch your fingers in and out on your trackpad to
zoom in and out of your artboard.

TIP

Design View versus Prototype Mode

Up to this point, you have been working in the default Design mode. This is the
view that you work in when creating artwork. Notice at the top of the XD work-
space that you have three different modes in which you can work: Design, Pro-
totype, and Share. You learn more advanced features about prototyping in the
following chapters of this minibook, but think of this as a quick run-through:

1 . Press Crtl+0 (Windows) or Command+0 (Mac) to make sure that you are
viewing all three of your artboards.

2. click Prototype in the Application menu.

Now you define an artboard to be your default screen; this is typically your
home screen. You'll discover later how to create more advanced interactions,
but for right now, start an initial flow. The home screen that was created in this
exercise is the first screen of the app. To default to that screen showing up
first, define it as the home screen.

3. Click the home artboard. A gray Home icon appears in the upper-left
corner. Click the Home icon. It turns blue, indicating that the artboard
is now successfully set as the start screen for your interactive prototype,
as seen in Figure 1-15.

Creating your links

Creating an interactive link is done by creating a wire from one screen to another.
You can now link your screens together. To do so, just follow these steps:
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FIGURE 1-15:
Click Prototype to
enter the mode
where you can
define the start
of your flow and
create links to
other screens.
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1.

Click the See dog text object on your home artboard. Notice that a blue
arrow appears to the right of the object. Click that arrow and drag a wire
from the dog text object to the dog artboard.

When you release, the target for your link is displayed. There are many options
in the Prototype mode, including the ability to link to other pages, create
animations, rollovers, show overlays, and more. These are listed as options in
the Type drop-down menu of the Properties menu. In this exercise, keep the
Type set to Transition.

Click the cat text object on the home page, click the blue connecting
arrow, and drag the wire to the cat artboard.

Allow users to return home by selecting the home-icon.svg icons on both
screens and clicking and dragging from the blue connecting arrow back
to the home artboard, as you see in Figure 1-16.

Testing your prototype

You can test your prototype by using the Desktop Preview feature:

1.
2.

Select the home artboard.

Click the Desktop Preview icon in the upper right of the XD workspace, as
shown in Figure 1-17.
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FIGURE 1-16:
Click and drag

a wire from the
object’s blue
connecting arrow
to the artboard
that you want to
link it to.

FIGURE 1-17:
Preview your
prototype by
clicking the
Desktop Preview
button.
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3.

Click on the objects that you defined as links, such as See dog, and See
cat, and the home icons.

You can either allow the Desktop Preview window to stay open while you
work — it will show live updates — or you can close it to keep it out of view.
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